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NEW QUESTION 1
HOTSPOT - (Topic 4)
You are configuring security to enable users to analyze data by using Microsoft Excel templates.
You create a security role named TemplateAdministrator and configure the role as shown below and assign the role to a user named User1.

Use the drop-down menus to select the answer choice that answers each question based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 2
DRAG DROP - (Topic 4)
You create multiple apps as part of an unmanaged solution. You need to move the apps to another environment.
You need to pick the appropriate solution type for each requirement.
Which types of solutions should you create? To answer, drag the appropriate solution types to the correct requirements. Each solution type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

Box 1: Unmanaged
Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.
Box 2: Unmanaged
Box 3: Managed
Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

NEW QUESTION 3
DRAG DROP - (Topic 4)
DRAG DROP
You are designing a new model-driven app for salespeople at a company.
The company requires that all new line-of-business apps must use a much native functionality as possible to avoid having developers maintain code.
You need to determine how to implement the app s business logic.
Which method should you use? To answer, drag the appropriate methods to the correct
requirements. Each method may be used once, more than once, or not at all. You may
NOTE: Each correct selection is worth one point.

A. Mastered
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B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 4
- (Topic 4)
You create a canvas app within a Power Platform environment.
You need to identify potential accessibility issues for the canvas app before making the app available to other users.
Which tool should you use?

A. Portal Checker
B. App Checker
C. Solution Checker

Answer: B

Explanation: 
Find accessibility issues
* 1. In the upper-right corner of Power Apps Studio, select the icon for the App checker.

* 2. In the menu that appears, select Accessibility.
A list of issues appears, sorted first by severity and then by screen.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 5
HOTSPOT - (Topic 4)
HOTSPOT
A company is creating an app to manage project status reports.
Users will update a series of controls and click a submit button. The submit button will calculate a risk score for the project and return to the previous screen with
that risk score. The risk score will be used in two different forms.
You need to create the formula on the button click. To answer, select the appropriate option in the answer area NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 6
- (Topic 4)
You create a canvas app.
You need to make the app available to other people in your company.
What are two possible ways to achieve the goal? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Grant access to individual users in your company.
B. Share the app with a Microsoft Exchange distribution list.
C. Grant access to a Microsoft Teams team.
D. Share the app with a Microsoft Azure Active Directory security group.

Answer: AD

Explanation: 
After you build a canvas app that addresses a business need, specify which users in your organization can run the app and which can modify and even reshare it.
Specify each user by name, or specify a security group in Azure Active Directory.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/share-app

NEW QUESTION 7
DRAG DROP - (Topic 4)
You ate designing an app to track time off for employees. Employee data, including employee ID number, is stored in an existing data source used by other apps.
Employees must be able to look up their employee ID number and enter time-off start and end dates in the app.
You need to configure the elements of the data source.
Which data elements should you use? To answer, drag the appropriate data elements to the correct data. Each data element may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 8
DRAG DROP - (Topic 4)
You create an app with multiple screens.
Test users report that the size and type of gallery displayed on each screen are different. You must improve the consistency for the app screens.
You need to create a reusable gallery that displays information based on the current record.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
NOTE: More than one order of answer choices is correct. You will receive credit for any of the correct orders you select.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
- Create a component
- Add an input property
- Add a gallery control
From https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/create-component step 10 and 11

NEW QUESTION 9
- (Topic 4)
You are using Test Studio to test a Power Apps canvas app. You need to ensure that the app conforms to several use cases. What should you do first?

A. Save the app to the cloud.
B. Create test cases for each requirement.
C. Save the app to your computer.
D. Create a test suite.
E. Record test cases for each requirement.

Answer: D

Explanation: 
Create a test suite.
By default, a test suite and test case are created for you in Test Studio. Test suites are used to organize your test cases.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-test-studio

NEW QUESTION 10
- (Topic 4)
You create a dashboard in Power BI. You share the dashboard with the sales team. Sales team members report that they can see information for the entire
company. You need to ensure that the team is able to see only data for their team.
Where must you configure this restriction?

A. Dashboard
B. Report
C. Dataset
D. Settings

Answer: C

Explanation: 
Restrict access to the dataset.
Note: Another way of setting access is through manage permission in the dashboard, report, or dataset. If you share a dashboard, by default the report and the
dataset will also be shared as read-only for users.
Reference:
https://radacad.com/dashboard-sharing-and-manage-permissions-in-power-bi-simple-but- useful

NEW QUESTION 10
- (Topic 4)
A company uses Power Apps in a single Microsoft Dataverse environment.
Users are divided into two groups about not a canvas app should work. The company decides that each group of users will try a version of the app for one week
and switch to the other version of the app the following week.
You need to manage the app creation. What should you do?

A. Create one app with two different version numbers.
B. Create one app with two different version notes.
C. Create two apps with the same name.
D. Create two apps with different app names.

Answer: A
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NEW QUESTION 14
HOTSPOT - (Topic 4)
A company uses Power Apps. The company gathers product improvement suggestions at tradeshows by using tablet devices.
A product improvement suggestion has two parts: a topic and a comment. Attendees can enter up to 10 suggestions. You create a canvas app to allow attendees
to enter suggestions. The wireless network connection inside the tradeshow is unreliable.
You need to ensure that the tablet devices save all suggestions.
Which solution technologies should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 18
- (Topic 4)
Each maker at a company has a separate Common Data Service environment. You are customizing a canvas app. You create two new entities in your
environment.
You are leaving for a vacation. Another maker will continue customizing the app in your absence.
You need to transfer the work to the other maker and ensure that you can work on the updated app when you return from your vacation.
What should you export?

A. ununmanaged solution that includes all customizations
B. the default solution
C. a managed solution that includes all customizations
D. the app

Answer: A

Explanation: 
Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.
Reference:
https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-ISV/Managed-vs-

NEW QUESTION 19
DRAG DROP - (Topic 4)
You create a canvas app for a store.
The logo must appear as the background image for the app. A loading spinner must display on the screen as the app loads.
You need to add the features to the app.
What should you modify? To answer, drag the appropriate form areas to the correct requests. Each form area may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 
Box 1: Screen
You can add an image to a screen in several different ways. One way is to upload an image to the app, go to the Media tab, and then click on the image to add it to
a screen.
Note: Configure graphical elements in your app, including images, photos, and elements of a pen control.
BackgroundImage – The name of an image file that appears in the background of a screen. Applies to the Screen control.
Box 2: Screen
Out Of Box Canvas App, provide a property called LoadingSpinner and LoadingSpinnerColor.
LoadingSpinner property is used to displaying a Canvas App OOB Loader Image unless your screen finishes loading.
Click on the Screen in your Canvas App and then You'll be able to see LoadingSpinner and LoadingSpinnerColor Property.

NEW QUESTION 22
- (Topic 4)
You create a model-driven app for salespeople.
Users must interact with a business process flow that invokes multiple tables. You need to instruct users where to find the business process flow, which
component should you use?

A. form
B. command bar
C. dashboard
D. site map

Answer: D

NEW QUESTION 25
HOTSPOT - (Topic 4)
A company uses a model-driven app. You create a Power BI sales report.
The executive of the company wants all users to see tiles from the report in the model- driven app.
You need to ensure all users can see the tiles.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Power Platform Environment settings
Before users can embed Power BI visualizations on personal dashboards, the organization-wide setting must be enabled.
? In the Power Platform admin center, select an environment.
? Select Settings > Product > Features.
? Under Embedded content set Power BI visualization embedding to On to enable or Off to disable.
? Select Save.
Box 2: Create a personal dashboard
You can embed Power BI tiles on your personal dashboard.
? Open your app and go to Dashboards.
? Select an existing personal dashboard or select New to create one.
? On the dashboard, select an area where you want the tile to appear, and then select Power BI Tile on the toolbar.
? Add new Power BI tile.
? In the Power BI Tile dialog, select the workspace and then select the Power BI tile that you want to display on your dashboard. Select Enable for mobile if you
want to make the tile available for Dynamics 365 for tablets and Dynamics 365 for phones.
? Select another area of the dashboard and repeat this step to add another Power BI tile, or other component, such as a chart or list, to your dashboard.
? Select Save to save your dashboard.
Box 3: Share report and share dashboard.
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To share your personal dashboard that contains Power BI visualizations you must
same credentials and appropriate level of access in both services. To share your personal dashboard in your app, go to Dashboards. In the list of dashboards,
select the personal dashboard you want, and then select SHARE DASHBOARD.

NEW QUESTION 26
HOTSPOT - (Topic 4)
You need to create a model-driven app without using code.
Which tools should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: App designer
As an app maker, you can create and edit public views by using Power Apps.
Box 2: Site Map designer
Site maps define the navigation for your app. Create a site map for your app with ease by using the tile-based site map designer.

NEW QUESTION 30
- (Topic 4)
A company receives its marketing campaign performance report as a Microsoft Excel file. The company stores the file in Microsoft SharePoint.
A user updates the Excel file daily with updated data.
The company needs a solution that automatically displays the latest analytics.
You need to create a basic report that contains pie charts that display the most profitable channels.
You need to propose the right solution.
Solution: Model-driven application using native charts. Does the solution meet the goal?

A. Yes

Answer: B

NEW QUESTION 33
DRAG DROP - (Topic 4)
DRAG DROP
A company is creating Power Apps apps for their customer service team.
You must create a final released solution to export to their test environment that cannot be changed in the new environment.
You need to determine the types of solutions to use.
Which type of solution should you use? To answer, drag the appropriate solution types to the correct conditions. Each solution type may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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Box 1: Unmanaged
Unmanaged solutions are used in development environments while you make changes to your application.
Box 2: Managed
Managed solutions are used to deploy to any environment that isn't a development environment for that solution.

NEW QUESTION 37
- (Topic 4)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.
Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.
You need to ensure that users can scan packing slip information into the form. Proposed solution: Use a Category classification model.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
A Category classification model categorizes text by its meaning. Reference:
https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/

NEW QUESTION 38
- (Topic 4)
You are an app maker. You are creating a canvas app. You do not have access to Power BI.
You need to add charts to the app.
Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. pie
B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation: 
You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:
* 1. On the Home tab, add a screen.
* 2. On the Insert tab, select Charts, and then select Column Chart.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 41
DRAG DROP - (Topic 4)
DRAG DROP
A company uses Microsoft Power Platform. Users create charts based on specific needs in
You create a solution in a development environment. You rebuild personal charts of the users inside the solution. All charts must appear on one page.
You need to create a single page that includes all charts without switching to classic. Which three steps should you perform in sequence? To answer, move the
appropriate
actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 43
DRAG DROP - (Topic 4)
DRAG DROP
A commercial bakery uses an inventory system to track ingredients consumed in their production line. The workers use iPads to interact with the system and
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reserve the ingredients for the next batch. Data from the system is extracted as a .csv file.
You need to create a Power Bl report from the extracted data by using only an iPad. Which five actions should you perform in sequence? To answer, move the
appropriate
actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 47
- (Topic 4)
A company uses Power Apps and Microsoft Dataverse. The company has a managed solution in the production environment
You make changes to the solution m the development environment. Some components are unused. The changes to the solution must be reflected in the
production environment
You need to ensure that all unused components are removed. What should you do?

A. Create a new solution
B. Upgrade the solution.
C. Update the solution.
D. Patch the solution.

Answer: B

NEW QUESTION 49
- (Topic 4)
You create a canvas app.
A user is not able to determine which field currently has focus. You run App checker to identify errors.
You need to verify that the focused border thickness is set to a value greater than zero. Which section of the App checker results should you check?

A. Rules
B. Performance
C. Accessibility
D. Runtime

Answer: C

Explanation: 
The Accessibility checker classifies each issue as an error, a warning, or a tip based the issue's severity.
Issues include:
? Focus isn't showing
When the FocusBorderThickness of a control is set to 0. It is good practice to ensure a proper color-contrast ratio between the focus border and the control itself
so it's clearly visible.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 53
DRAG DROP - (Topic 4)
A company is building multiple Power Apps apps to support a mobile sales team. The apps must all share a common control that has custom properties.
You need to create a solution for the apps.
Which objects should you use? To answer, drag the appropriate objects to the correct to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Component library
Components are reusable building blocks for canvas apps so that app makers can create custom controls to use inside an app, or across apps using a component
library. Components can use advanced features such as custom properties and enable complex capabilities.
By creating a component library, app makers easily share and update one or more components with other makers.
Component libraries are containers of component definitions that make it easy to: Discover and search components.
Publish updates.
Notify app makers of available component updates.
Box 2: Component
A component can receive input values and emit data if you create one or more custom properties.

NEW QUESTION 56
- (Topic 4)
A company plans to roll out several Power Apps apps to multiple business units across international operations.
The apps must be managed through an application lifecycle management (ALM) solution to provide a consistent and predictable use experience. All changes to
the app must be traceable and documented in a single location. You must be able to revert to a previous version of an app. The app release cycles must be as
streamlined as possible.
You need to create an application for the apps.
Which two tools should you use? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Microsoft Azure DevOps
B. Microsoft Visual Studio
C. Lifecycle Services
D. AppSource
E. Common Data Service

Answer: AD

Explanation: 
A: DevOps is the combining of two historically disparate disciplines: software development
and IT operations. The primary goal of DevOps is to shorten the software development lifecycle and provide continuous integration and continuous delivery
(CI/CD) with high software quality. You can use Power Apps build tools to automate common build and deployment tasks related to Power Apps if your DevOps
platform is Azure DevOps.
D: Microsoft AppSource is now embedded in the Dynamics 365 home page and throughout the common navigation. It now includes a private gallery of apps
available to you within your company. Select Get more apps from the home page or task pane, and navigate to the My Organization tab to see apps that are
available to you.
Reference:
https://docs.microsoft.com/en-us/power-platform/alm/devops-build-tools https://docs.microsoft.com/en-us/powerapps/user/app-source

NEW QUESTION 59
- (Topic 3)
You need to design the data model for the cooking classes.
What should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 62
DRAG DROP - (Topic 3)
You need to create the food bank notification.
Which four actions should you perform in sequence? To answer, move the appropriate

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 67
DRAG DROP - (Topic 3)
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You need to select a design approach for the required features.
Which app type should you use? To answer, drag the appropriate app types to the correct requirements. Each app type may be used once, more than once, or not
at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 71
HOTSPOT - (Topic 2)
You need to implement features for the solution.
Which Power Platform component should you use for each feature? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Model-driven app
The Sales app must meet the following requirements:
? Provide a central location for all sales pipeline and quote information that is easily accessible and maintains all of the versions of the estimate, quote, and
engineering documents.
Compared to canvas apps, model-driven apps in PowerApps are based on underlying data
— specifically, the data stored in Common Data Service (CDS).
Box 2: Power BI Desktop
You can create a KPI in Power BI Desktop.
? Open your report editor in Power BI Desktop then select a report on which you are working.
? On your right, you will see a Visualizations pane and a Fields pane.
? From the Visualizations pane, select the KPI visual.
? Etc.
Box 3: Power Automate

NEW QUESTION 73
HOTSPOT - (Topic 2)
You need to configure the system to meet the sales requirements.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Use a Business Process flow
Scenario: The Sales Log app must enforce process standards related to the completion of estimates and supporting materials needed during the sales lifecycle.
Box 2: Use a formula to set the DisplayMode property
DisplayMode - The mode to use for data cards and controls within the form control. Derived from the Mode property based and cannot be set independently:

NEW QUESTION 74
HOTSPOT - (Topic 2)
If you add one or more Image controls to your app, you can show individual images that aren't part of a data set, or you can incorporate images from records in
data sources.
You need to configure the system to meet the requirements.
What should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: 1:N
Scenario: A sortable listing of all in-process jobs from the Job Setup table, by customer, start date, and product.
Box 2: User or Team owned
Scenario: Employees must only be able to access their own time tracking records from the app.
User or team: Data belongs to a user or a team. Actions that can be performed on these records can be controlled on a user level.

NEW QUESTION 75
- (Topic 2)
You need to modify the entity form to resolve the customer request number issue. What should you do?

A. Use a calculated field
B. Change the data type of the customer request number field to Lookup
C. Change the data type of the customer request number field to Autonumber

Answer: C

Explanation: 
Scenario: Users report that the customer request number is difficult to interpret. They request that you change the number to a system generated sequential
number. Autonumber columns are columns that automatically generate alphanumeric strings whenever they are created.
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Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/autonumber-fields

NEW QUESTION 80
HOTSPOT - (Topic 1)
You need to configure the app to meet the requirements.
Which object properties should you configure? To answer, select the appropriate options in
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Fill
Scenario: You must display a visual indicator in the app so that sales representatives know whether the app is offline before submitting reports.
Fill – The background color of a control.

NEW QUESTION 83
DRAG DROP - (Topic 1)
You need to modify the app design to meet the accessibility needs of the sales associates.
Which properties should you configure? To answer, drag the appropriate properties to the correct restrictions. Each property may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 Graphical user interface, text, application Description automatically generated
Box 1: AccessibleLabel
Scenario: Before deploying the app to production, you must ensure that the app conforms to Microsoft accessibility and performance guidelines.
User2 is visually impaired and cannot see images. AccessibleLabel is a label for screen readers.
An empty value for Image, Icon, and Shape controls will hide the controls from screen reader users.
Box 2: TabIndex
User3 is unable to use a mouse.
TabIndex determines if the control participates in keyboard navigation.
Keyboard navigation is an important aspect of any app. For many, the keyboard is more efficient than using touch or a mouse. The navigation order should:
Mirror what is seen visually.
Only have a tab stop at controls that are interactive.
Follow either an intuitive across and then down "Z" order or a down and then across "reverse-N" order.

NEW QUESTION 88
- (Topic 1)
You need to configure functionality for submitting status reports. What should you do?
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A. Determine whether the application is offline when a user selects submit button and call the Sec () function.
B. Determine whether the application is offline when the app load
C. Use the SaveDaca () function in the OnSelect property.
D. Determine whether the application is offline when a user selects the submit button and call the SaveDaca () function.
E. Determine whether the application is offline when the app load
F. Use the LoadDaca () function in the Submit button.

Answer: C

Explanation: 
Scenario: The app must be able to run both online and offline. If the mobile device on which the app runs is connected to the internet, the app must immediately
submit the status report.
When data is submitted offline, the data must be stored in the app until the app is back online.
Mobile users often need to be productive even when they have limited or no connectivity. LoadData and SaveData combine to form a simple mechanism to store
small amounts of data on a local device. By using these functions, you can add simple offline capabilities to your app.
The SaveData function stores a collection for later use under a name.
The LoadData function reloads a collection by name that was previously saved with SaveData. You can't use this function to load a collection from another source.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-

NEW QUESTION 91
- (Topic 1)
You need to provide the app to Tailwind Traders. What should you do?

A. Within Managed Properties, set the value of the Allow customizations option to tru
B. Export the app as a managed solution.
C. Use the Share App feature.
D. Within Managed Properties, set the value of the Allow customizations option to fals
E. Export the app as a managed solution.
F. Within Managed Properties, set the value of the Allow customizations option to fals
G. Export the app as an unmanaged solution.

Answer: C

Explanation: 
Scenario: The completed app and all supporting components must be provided to Tailwind Traders. Tailwind Traders must not be able to make changes to any of
the components.
Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.
Reference:
https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-ISV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 94
HOTSPOT - (Topic 4)
You are creating a Power Automate flow.
You have an array that contains items with different color attributes. You plan to filter the array by using the following filter expression within the flow:
@or(equals(item()?['color'], 'red'),contains(item()?['color'],'blue')) The filter returns results only when the expression resolves to true.
For each of the following statements, select Yes if the statement is true. Otherwise, select No.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: No
Box 2: Yes
The item color must be red, or item color contains blue. Box 3: Yes

NEW QUESTION 97
- (Topic 4)
A company uses Power Apps. The company creates a solution that contains the following items:
• environment setting
• flow that accesses Microsoft Dataverse
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• plug-in with an unsecure configuration
• environment variable with a default value
The company plans to import solutions manually.
You need to document the solution component type that prompts for user input. Which component type should you document?

A. Environment variable
B. Environment setting
C. Connection reference

Answer: D

NEW QUESTION 102
DRAG DROP - (Topic 4)
You are creating a model-driven app for onboarding new employees. You need to implement business logic for the app.
Which tool should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You may
need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Business process flow
A business process flow is a visual guide meant to help users complete a business process by using a set of predefined stages. Users are not limited on how long
they run a business process or how long they have a stage open.
Box 2: Business rule Box 3: Power Automate
A Power Automate flow does not have any visual components like a business process flow.
Power Automate flows can be configured to work with many different data sources, and a flow can connect to many different data sources within the same flow. A
flow can be configured to time out if it is not completed in a certain time and can be triggered to move between steps based on data or user interaction.

NEW QUESTION 106
DRAG DROP - (Topic 4)
A company stores sales orders in a Microsoft Excel workbook. The company stores customer data in a SQL Server database.
You must import the data into a Microsoft Dataverse instance. You need to define the mapping for the migration.
Which component should you use? To answer, drag the appropriate components to the correct data type. Each component may be used once, more than once, or
not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Table
Box 2: Data source Box 3: Column
Box 4: Row

NEW QUESTION 108
HOTSPOT - (Topic 4)
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The managers in an organization use a model-driven app. The app should display only one dashboard named Corporate Data.
The managers observe that several dashboards are displayed.

Use the drop-down menus to select the answer choice that answers each question based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Table
Description automatically generated
Box 1: Open the model-driven app in the app designer.
* 1. On the app designer canvas, select the Dashboards tile.
On the app designer canvas, the right pane shows dashboards that are available in the default solution.
* 2. Clearing the corresponding check box.
Box 2: Open the site map in the sitemap designer and delete the Ideas dashboard from the Results group
Site maps define the manner by which users move between tables in a model-driven app.

NEW QUESTION 112
- (Topic 4)
A company uses Microsoft Power Apps.
You need to create a canvas app to display a Microsoft Power BI report. The report must use the context of a selected record in the app. Data in a Power BI
control must be filtered to display the context of the selected record.
You need to propose the right solution.
Solution: Add Power Apps to Power BI using Power Apps for Power BI visualization. Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 117
- (Topic 4)
DRAG DROP
A company uses Microsoft Power Platform in a production environment. The company is defining new business processes in a prototyping environment. You
create components in both environments.
You need to package the components you create.
Which solution types should you use? To answer, drag the appropriate solution types to the connect components. Each solution type may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 120
- (Topic 4)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are developing a model-driven app that uses a Common Data Service database. App users will have a variety of different security roles.
Development and testing must be performed using production data. Multiple testers must be used at each testing stage.
You need to provision and configure new environments for development and testing. Solution:
? Provision sandbox environments named S1 and S2.
? Copy the production environment to both S1 and S2.
? Use S1 for development and S2 for testing.
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
A sandbox environment is any non-production environment of Microsoft Dataverse. Isolated from production, a sandbox environment is the place to safely develop
and test application changes with low risk.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/environments-overview

NEW QUESTION 125
HOTSPOT - (Topic 4)
You are a technical assistant for a legal services organization. The company uses SharePoint to manage documents and Microsoft Dataverse as the data store.
The company has strict rules about access, permissions, and privacy.
Lawyers and paralegals use Microsoft Teams for communications and collaboration. Employees use personal devices to access legal files. You do not have
access to the admin area in Microsoft Power Platform.
You need to ensure that these rules are observed consistently and managed in one place.
Which type of app should you create? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Model-driven app in Microsoft Teams
A user's ability to see and use apps is controlled by sharing the application with the user. Sharing of canvas apps is done directly with a user or Azure AD group
but is still subject to Dataverse security roles. Sharing of model-driven apps is done via Dataverse security roles.
Box 2: Sharepoint Calendar
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NEW QUESTION 129
- (Topic 4)
You create a custom table as part of a solution in the development environment. You deploy major version solutions as managed solutions to production. The
organization does not allow new solutions to be created in the production environment.
When a minor update is made to a column length, users cannot enter entire values. You need to allow users to enter entire values in the column.
Solution: Update the column length in the production environment. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 132
- (Topic 4)
You create a new solution publisher and include a publisher prefix value.
Which two actions can you perform? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. You can change contact details of a publisher after you create the publisher
B. When you change a solution publisher prefix, you can change the schema name for existing components
C. You can change the schema name of a publisher after creating the publisher
D. You can add a component from one solution to another solution that has a different publisher

Answer: AD

Explanation: 
Once you introduce a publisher for a component in a managed solution, you can’t change the publisher for the component.
Reference:
https://docs.microsoft.com/en-us/power-platform/alm/solution-concepts-alm#solution- publisher

NEW QUESTION 136
HOTSPOT - (Topic 4)
A company uses two SQL Server environments and two Common Data Service environments.
The company policy states that only specific administrators can create environments. SQL Server and Common Data Service groups must be distinct.
You need to assign security access.
What should you assign? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: System Administrator and Environment Security group Security model for the databases
When a database is created, the users who have environment roles assigned to them, will continue to maintain those privileges.
Users with Environment Admin role are now assigned to System Administrator role. Users with Environment Maker continue to possess the same role.
Box 2: Environment Admin
TheEnvironment Adminrole can perform all administrative actions on an environment, including the following:
? Add or remove a user from either the Environment Admin or Environment Maker role.
Box 3: Environment Maker
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Environment Maker: Can create new resources associated with an environment, including apps, connections, custom APIs, gateways, and flows using Microsoft
Power Automate. However, this role doesn't have any privileges to access data within an environment. More information:
Box 4: System Customizer
System Customizer: Has full permission to customize the environment. However, users
with this role can only view records for environment entities that they create.

NEW QUESTION 140
DRAG DROP - (Topic 4)
You are creating a Power Automate cloud flow.
The data in the flow must perform the following actions:
• Return the first character of a string of text.
• Convert an array to a single string. You need to manipulate the data.
Which data operations should you use? To answer, drag the appropriate data operations to the correct changes. Each data operation may be used once, more
than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 141
- (Topic 4)
You receive ideas from employees in a Microsoft Teams channel. Managers are not members of the Teams channel Submissions must be reviewed by three
managers who are determined by submission type. You need approval from the managers to process submissions. What should you create?

A. approval request in the Teams channel that requires a response from all approvers
B. approval request in a chat with the three managers that requires a response from all approvers
C. approval template that requires responses to be completed m order
D. approval template that requires a response from all approvers

Answer: B

NEW QUESTION 144
- (Topic 4)
An inside sales staff uses three model-driven apps for their sales process. Each app includes the same custom specialized component.
You must standardize the inside and outside sales process by creating a canvas app that has the same functionality as the three model-driven apps. You do not
have administrator permissions.
You need to incorporate the logic of the custom component in the outside sales canvas app.
Where should you build the custom component?

A. Custom control
B. Component library
C. Any of the three apps
D. Solution

Answer: B

NEW QUESTION 147
DRAG DROP - (Topic 4)
You are designing a canvas app.
You need to select user interface controls to include in the app.
Which control should you use? To answer, drag the appropriate controls to the correct requirements. Each control may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: List box
A List Box control always shows all available choices (unlike a Drop down control) and in which the user can choose more than one item at a time (unlike a Radio
control).
Box 2: Combo box
A Combo box control allows you to search for items you will select. The search is performed server-side on the SearchField property so performance is not
affected by large data sources.
Single or multi-select mode is configured via the SelectMultiple property.
When searching for items to select, for each item you can choose to show a single data value, two values, or a picture and two values (Person) by modifying the
Layout settings in the Data pane.

NEW QUESTION 149
- (Topic 4)
A company uses Microsoft Power Apps.
You need to create a canvas app to display a Microsoft Power BI report. The report must use the context of a selected record in the app. Data in a Power BI
control must be filtered to display the context of the selected record.
You need to propose the right solution.
Solution: Add a slicer to a Power BI element on the screen where data is selected. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 151
HOTSPOT - (Topic 4)
A company is using Power Automate to send an email with all active projects that are at risk.
Projects that are stored in a table in Microsoft Dataverse are deemed at risk if the column for a risk score is greater than 70 or has a zero value.
The flow will loop over all the records in the Dataverse Projects table and update the risk status field based on the risk score.
You need to create a single evaluation expression to update the risk status field.
Which expression component should you use? To answer, select the appropriate options in
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 156
DRAG DROP - (Topic 4)
You have the following Common Data Service entities: BusinessContracts and
You need to configure an N:N relationship between the two entities.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Open the relationship tab of the BusinessContracts entity. View entity relationships
From the Power Apps portal, select either Model-driven or Canvas design mode. Select Data > Entities and select the entity that has the relationships you want to
view. With the Relationships tab selected, you can select the following views:
Step 2: Select Add relationship.. Create relationships
While viewing entity relationships, in the command bar, select Add relationship and choose Many-to-many.
Step 3: Select the BusinessAccounts entity as the related entity.

NEW QUESTION 158
- (Topic 4)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
A company has locations in multiple countries and regions across four continents. The company stores the total amount of each order in the local currency of the
country/region where the customer is located. The company stores the applicable
exchange rates in a custom US dollars (USD) exchange rate table.
You need to create a visualization that displays the total amount of orders by country/region in USD.
Proposed solution:
Create a custom column that converts the order total to USD by using the relationship between order local currency and the USD exchange rate table in Power BI
Desktop and display this column in a Power BI chart by country/region.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead use a calculated field.
Need to calculate the exchange rate in USD.
Calculated columns are calculated in real-time when they are retrieved. Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/calculated-rollup- attributes

NEW QUESTION 160
- (Topic 4)
You are creating a canvas app for a company that delivers packages. The app will display one screen for each delivery attempt.
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Drivers must make three attempts to deliver a package before returning the package back to a warehouse. Drivers must enter details about delivery on a second
screen in the app.
You need to display a list of delivery attempts on the delivery screen.
Which two components can you add to the app to display details about the delivery attempts? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Data table
B. Vertical gallery
C. Display form
D. Drop-down

Answer: AC

Explanation: 
The Data table control shows a dataset.
In a canvas app, add and configure a Display form control to show all fields in a record. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-data-table https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/working-with-form-layout

NEW QUESTION 162
- (Topic 4)
You complete work on a new canvas app in a development environment and add the app to a solution. You export the solution from the development environment
and import the solution into a production environment.
After several days you notice that the background color for the canvas app in the production environment has changed from white to grey.
You need to determine why the background color changed.
What are two possible causes for the background color change? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. You recently changed the Office 365 theme.
B. You exported a managed copy of the solution and imported the solution as an unmanaged solutio
C. You modified the canvas app in the unmanaged solution.
D. You exported and imported an unmanaged copy of the solution and a co-worker modified the canvas app.
E. You chose a different theme from the Theme menu inside the canvas app.

Answer: AC

Explanation: 
A: You can create a custom look and feel (a theme), for your app by making changes to the default colors and visual elements provided in the uncustomized
system.
C: Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test
any of the components of the solution. You also have the ability to create restrictions on the components within the solution.
Note: Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by
setting restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited.
Reference:
https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-ISV/Managed-vs-Unmanaged/td-p/495685
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-themes-organization-branding

NEW QUESTION 166
- (Topic 4)
The postal service uses a system based on the Microsoft Database to manage the delivery of packages.
To improve the delivery service, the management requires the delivery staff to use personal cell phones to communicate the location and the exact time of each
delivery.
You need to design a solution. What should you do?

A. Create a button flow with user input for the delivery time and location
B. Create a Ul flow that sends the delivery time and location
C. Create a button flow with full address and timestamp trigger tokens

Answer: B

Explanation: 
Button trigger tokens are data points that are known and available to the device on which a button flow is running. These tokens change based on factors such as
the current time or the geographic location of the device at a given moment.
Note: For example, if you are running a button flow on a smart phone, it is likely that the phone knows the time at your current location as well as the date and your
current address. In this context, the time, date and address where the phone is located are all determined at the time the button flow runs. They are automatically
available for use in any button flows that are executed on the device. You can use these trigger tokens to build useful flows that will minimize repetitive tasks such
as providing your location to someone or tracking how much time you spent on a particular job/service call.
Reference:
https://docs.microsoft.com/en-us/power-automate/introduction-to-button-trigger-tokens

NEW QUESTION 171
- (Topic 4)
A company has a Common Data Service custom entity that stores customer account data. You need to create a relationship between the custom entity and the
Account entity. Which two tools can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Power Platform Admin center
B. Power Apps Maker portal
C. SQL Server Management Studio
D. Visual Studio Code
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Answer: BC

Explanation: 
There are two designers you can use to create and edit 1:N (one-to-many) or N:1 (many-to- one) relationships:
? You can create and edit 1:N (one-to-many) or N:1 (many-to-one) entity relationships in Power Apps portal
? You can create and edit create and edit 1:N (one-to-many) or N:1 (many-to-one) entity relationships using solution explorer
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-1n- relationships

NEW QUESTION 175
- (Topic 4)
A company is onboarding new workers to the Microsoft Power Platform.
A user reports an access issue with a Power Apps app. The user provides no additional information about the access issue.
You need to troubleshoot the app and data security configurations for the user. Which tool should you use?

A. Azure AD Security review
B. User information page
C. Accessibility checker
D. Run diagnostics

Answer: D

Explanation: 
User access diagnostic tool in the Power Platform admin center:
Several factors influence user access in a Microsoft Dataverse environment. To help administrators with diagnosing user access to an environment and reasons
for access or no access, the new “Run diagnostics” feature in the Power Platform admin center provides basic access diagnostics for individual users in the
environment. The feature helps to detect potential causes to user sign-in and other issues and suggests potential mitigations.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/troubleshooting-user-needs-read-write-access-organization

NEW QUESTION 179
HOTSPOT - (Topic 4)
A company uses Microsoft Power Platform. The company categorizes customers into Specialty shop, Grocery store, Wholesaler, and Seasonal market groups by
using a custom choice type column.
The staff uses a model-driven app with an interactive dashboard that displays all customer
You must update the app to provide the following functionality:
• Display selected customers by type in the interactive dashboard.
• Search for customers across multiple tables by postal code by entering any number of characters.
You need to configure the system.
Which configuration options should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 180
DRAG DROP - (Topic 4)
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You have a canvas app that uses multiple inputs for calculations.
You must use Test Studio to create automated tests and confirm that the app works as expected.
You need to organize your test scenarios into a hierarchy.
In which order should you create the objects? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct
order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Test suites
By default, a test suite and test case are created for you in Test Studio. Test suites are used to organize your test cases. An app can contain one or more test
suites.
Step 2: Test cases
Depending on how you want to organize or group your tests, you can create multiple test cases in a test suite. Each case can test a specific feature or a subset of
functionalities in your app.
Step 3: Test steps Step 4: Test assertions
A test case consists of test steps that contain actions. Test actions are written using Power
Apps expressions that perform a task. You can use the recorder to automatically generate the test steps as you interact with your app. After you record, you can
update the test case, add new steps, delete steps, and write test assertions to validate the result of your test.

NEW QUESTION 184
- (Topic 4)
You are an app maker.
You want to create apps and track customizations as part of the default solution. You need to determine the impact of performing the work in the default solution.
What should you conclude?

A. The default solution does not contain all components and customizations from all solutions in the environment.
B. The prefix used when creating components as part of the default solution can be set to a specific value.
C. The default solution cannot be exported and distributed to another environment.

Answer: C

Explanation: 
Default Solution. This is a special solution that contains all components in the system. The default solution is useful for discovering all the components and
configurations in your system.
Why you shouldn't use the default solutions to manage customizations
There are a few reasons why you shouldn't create apps and make customizations in either of the default solutions:
? The default solution can't be exported; therefore, you can't distribute the default solution to another environment.
The default solution contains all components and customizations from all solutions in the environment.
By default, all enabled users can create apps and customize components in the Common Data Services Default Solution.
It's difficult to locate or identify the customizations you've made in the environment by using either default solution.
When you use either default solution to create components, you'll also use the default publisher assigned to the solution. This often results in the wrong publisher
prefix being applied to some components.
Reference:
https://docs.microsoft.com/en-us/power-platform/alm/use-solutions-for-your-customizations

NEW QUESTION 187
DRAG DROP - (Topic 4)
DRAG DROP
A company is migrating to a new Microsoft 365 tenant. You create an expense
You need to move the latest version of the canvas app and cloud flow to the new tenant. Which three actions should you perform in sequence? To answer, move
the appropriate
actions from the list of actions to the answer area and arrange them in the correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 190
- (Topic 4)
A company is using Power Virtual Agents in Microsoft Teams to expose Microsoft Dataverse data to employees.
You create a chatbot that retrieves a list of customers by postal code from a Dataverse table. The chatbot will accept requests from a user and must connect to
Dataverse to retrieve the data.
You need to connect the chatbot to the Dataverse table. What should you use?

A. Table
B. Power Apps
C. Microsoft Teams
D. Power Virtual Agents
E. Power Automate

Answer: C

Explanation: 
Dataverse for Teams is the “lite” version of Dataverse. It is a low-code platform designed to build relatively simple (but still powerful) apps, using a user-friendly
interface and remaining within Microsoft Teams. This new update means that users now have the possibility to create Power Apps apps, Power Automate flows
and Power Virtual Agents bots without leaving the Teams platform.
Reference:
https://docs.microsoft.com/en-us/learn/paths/work-power-platform-teams/
https://docs.microsoft.com/en-us/learn/modules/create-chatbot-power-virtual-agents-dataverse-teams/5-call-action-pull-data

NEW QUESTION 192
- (Topic 4)
You create a Power Platform solution. Solution data is stored in a variety of documented cloud services.
You need to configure the data sources. What should you do?

A. Create a data gateway.
B. Use a content pack.
C. Create a custom data connector.
D. Add metadata to standard entities.

Answer: B

Explanation: 
Common Data Model is built upon a rich and extensible metadata definition system that enables you to describe and share your own semantically enhanced data
types and structured tags, capturing valuable business insight which can be integrated and enriched with heterogeneous data to deliver actionable intelligence.
Common Data Model can be used by various applications and services including Microsoft Dataverse, Dynamics 365, Microsoft Power Platform, and Azure
ensuring that all of your services can access the same data.
Note: A wide variety of applications and services can easily access data in a data lake, however, each consumer must understand the format and meaning of the
data before it can provide value. The Common Data Model simplifies this process by providing a metadata system that describes the data and standard entities to
which producers can map.
Reference:
https://docs.microsoft.com/en-us/common-data-model/use

NEW QUESTION 195
- (Topic 4)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.
Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.
You need to ensure that users can scan packing slip information into the form. Proposed solution: Use a Key Phrase Extraction model.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
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The key phrase extraction prebuilt model identifies the main points in a text document.
Reference:
https://docs.microsoft.com/en-us/ai-builder/prebuilt-key-phrase

NEW QUESTION 196
DRAG DROP - (Topic 4)
DRAG DROP
You are creating a Power Automate cloud flow to update a column on each Item in a list of Microsoft Dataverse records. Records are sorted in order of priority.
You must use a complex expression to determine the column value. The column value must be stored in a variable to make future maintenance easier. Records
must be processed based on the sorted order.
You need to add flow steps to process the list of records.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 199
- (Topic 4)
Engineers in an organization plan to attend an international product show.
The engineers must be able to capture information about presented products based on personal assessment and interest. The engineers must capture the
information by taking pictures of the booth, brochures, and other product-specific materials.
You need to provide a button flow to streamline the process.
Which two AI Builder models should you use? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Language detection
B. Sentiment analysis
C. Category classification
D. Business card reader
E. Form processing

Answer: AD

Explanation: 
International product show: The language detection prebuilt model identifies the predominant language of a text document. The model analyzes the text and
returns the detected language and a numeric score from 0 through 1. Scores close to 1 indicate higher confidence in the result. The detected language is returned
as the "script" of the language. For instance, for the phrase "I have a dog", it will return"en"instead of"en-US". The response for languages that can't be detected
isunknown.
Use the AI Builder business card reader component to detect business cards and extract their information. You can take photos directly in the component or load
images that you've taken. Data is extracted and identified by using the properties listed below.
Reference:
https://docs.microsoft.com/en-us/ai-builder/prebuilt-language-detection https://docs.microsoft.com/en-us/ai-builder/business-card-reader-component-in-powerapps

NEW QUESTION 200
HOTSPOT - (Topic 4)
A company uses several forms for biannual performance evaluations. The company several performance areas that have a score of 1-10. A paragraph explains
the score.
The company must scan completed performance evaluations into a Common Data Service entity by using a Power Apps app. The information in the documents
must automatically map to entities and convert into quantifiable information.
If any key phrases in the scored topics cause concern, the company must follow a series of actions to prepare for a follow up.
You need to extract the information and perform the actions when the evaluations are scanned.
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Which component should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: AI Builder
The object detection component of AI Builder for PowerApps takes a photo or loads an image file to do an object detection scan. On a mobile device, the user
chooses between taking a photo or selecting one already available in the device user interface. When an image is selected, the component automatically scans it
to identify objects.
Box 2: Extract entities and their types from text
The Entity extraction prebuilt model identifies and classifies key elements from text into pre-defined entities. You can use the prebuilt model out of the box in power
apps and power automate.
Box 3: Scope
Scope is a simple way to put similar actions and conditions together like a Stage.

NEW QUESTION 203
DRAG DROP - (Topic 4)
You create a custom field on the Account entity.
Members of TeamA must have full access to the field. Members of TeamB must have no access to the field.
You need to configure security.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Step 1: Enable field security for the field
Step 2: Create a field security profile and set all the permissions for the custom attribute to Yes.
Step 3: Add TeamA to the field security profile.
Note: Field-level security is available for the default fields on most out-of-box entities, custom fields, and custom fields on custom entities. Field-level security is
managed by the security profiles. To implement field-level security, a system administrator performs the following tasks.
? Enable field security on one or more fields for a given entity.
? Associate one more existing security profiles, or create one or more new security profiles to grant the appropriate access to specific users or teams.

NEW QUESTION 206
HOTSPOT - (Topic 4)
You are developing an app for a package delivery company. Delivery team members will use the app on their phones. Distribution center team members will use a
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web-based version of the app that runs on tablet devices.
When a delivery person arrives at a location and the package recipient is present, the app must capture the recipient's signature. If the recipient is not available,
the app must capture a picture of the drop-off location or the person receiving the package.
You need to design phone-based and web-based versions of the app.
Which app type and media control should you use? To answer, configure the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
App Type: Screens
To insert the Camera control in your PowerApps program you can use the blank screen, and select Insert->Media->Camera.
Media Type: Camera
Use the Camera control to capture pictures with a device's camera. The device must have a camera and the user must authorize the app to use the camera.
Tap or select the camera control to capture a picture from the camera.
The most recently captured picture is available through the Photo property. With this property, the images can be:
? Viewed with the Image control. Use the Image control to view the captured image.
? Temporarily put in a variable or a collection.
? Stored in a database.
? Transmitted as a base64 encoded text string.

NEW QUESTION 208
- (Topic 4)
You create a canvas app named Hardware Order that suggests computer hardware to customers.
A value must be entered for the EmployeeID field when creating a new order if the value in the OrderType field does not contain the prefix test.
You need to configure the business rule.
Which two actions should you perform? Each correct answer presents part of the complete solution.
NOTE: Each correct selection is worth one point.

A. Set the scope of the business rule to Entity.
B. Add a Recommendation action and configure it to enter the order type.
C. Set the scope of the business rule to All Forms.
D. Use the following condition expression:(OrderType Does not begin with [test]) AND (Modified By Does not contain data)

Answer: AD

Explanation: 
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

NEW QUESTION 213
- (Topic 4)
You are creating an employee directory canvas app. The app must display name, address,
and a photo of each employee. You need to select a control type that will display the

A. Address input
B. List box
C. Gallery
D. Data table

Answer: C
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NEW QUESTION 216
HOTSPOT - (Topic 4)
A company is building a canvas app.
A user needs to understand which data they can make available for the 500 contacts that are present in the Contact table. All relevant data must be shown in the
app. Single fields must show one record and grids must show multiple records. Only the primary fields for each related table should be shown for a contact.

Use the drop-down menus to select the answer choice that answers each question based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Use a single field for Contact table and a grid for the Connection table The Contact table is on 1-side of the 1-to-many relation to the Connection table.
Box 2: Use a single field for Team table and a grid for the Connect table The Team table is on 1-side of the 1-to-many relation to Contact.

NEW QUESTION 221
- (Topic 4)
You are designing an interactive report for a model-driven app. The report will use more than five million records. The query that retrieves data for the report
requires more than five minutes to complete.
You need to create the report. Which option should you use?

A. Interactive dashboard
B. Power Bl
C. Standard dashboard

Answer: B

NEW QUESTION 226
HOTSPOT - (Topic 4)
A company uses Power Apps and Microsoft Dataverse. You create a model-driven app that has no flows, workflows, or plug-ins.
The app requires a main form that has a form field named reference number. The reference number must perform the following activities:
• Autogenerate when new records are created.
• Follow the format xx/yy, where xx is an incremental number and yy indicates the last two digits of the current year.
You need to ensure that each record created in the Microsoft Dataverse table follows this format. Which features should you use? To answer, select the
appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Passing Certification Exams Made Easy visit - https://www.2PassEasy.com



Welcome to download the Newest 2passeasy PL-100 dumps
https://www.2passeasy.com/dumps/PL-100/ (224 New Questions)

Answer: A

Explanation: 

NEW QUESTION 228
- (Topic 4)
A company uses a canvas app to encourage employees to take reading breaks during their work schedule. The reading breaks are created automatically as
Outlook tasks in the employees Outlook app. The app must trigger a Power Automate cloud flow when specific data is captured in the canvas app. You need to
create and configure the flow. Which flow step should you configure first?

A. Flow button for mobile
B. Power Apps step with trigger conditions
C. New Microsoft Outlook task
D. Condition step

Answer: A

NEW QUESTION 233
- (Topic 4)
A company is implementing the Microsoft Power Platform to assist with consolidation of onsite inspections and audits of retail stores. Currently, the data used by
the retail store inspections is located across multiple systems.
The canvas app must use one database to view and record all data used in the inspection process.
You need to design the solution.
Which three capabilities should you implement? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Use an embedded access management framework for user security.
B. Execute real-time data operations against external data sources through virtual entities.
C. Store data used by a Power Apps app on both iOS and Android mobile platforms.
D. Use Azure Data Lake storage to host the transactional data.

Answer: BCE

Explanation: 
B: Virtual tables (also known as virtual entities) enable the integration of data residing in external systems by seamlessly representing that data as tables in
Microsoft Dataverse, without replication of data and often without custom coding.
CE: Authenticating to a Gen 1 DataLakeStore Account Gen 1 uses OAuth 2.0 in Azure AD for authentication.
Reference:
https://www.cdata.com/kb/tech/azuredatalake-odata-powerapps.rst

NEW QUESTION 237
HOTSPOT - (Topic 4)
: 189 HOTSPOT
A company is building several Power Apps apps to help with sales operations collaboration. You need to identify the right solution for data storage.
Which solution should you use? To answer select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 

NEW QUESTION 240
- (Topic 4)
You create a custom table as part of a solution in the development environment. You deploy major version solutions as managed solutions to production. The
organization does not allow new solutions to be created in the production environment.
When a minor update is made to a column length, users cannot enter entire values. You need to allow users to enter entire values in the column.
Solution: Uninstall the most recent version of the solution from the production environment. Does the solution meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 244
- (Topic 4)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating a canvas app.
You need to automatically detect bicycles in pictures taken with the camera. Proposed solution:
? Create a Category Classification custom model in AI Builder.
? Train the model with pictures of bicycles and then publish the trained model.
? Add the Object Detector control to your canvas app.
Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation: 
Instead create an Object Detection custom model Reference:
https://docs.microsoft.com/en-us/ai-builder/prediction-overview https://docs.microsoft.com/en-us/ai-builder/object-detector-component-in-powerapps

NEW QUESTION 249
DRAG DROP - (Topic 4)
A company must use a Power Apps app custom control that is exported from a different canvas Power Apps app.
You need to insert the custom control into the Power Apps app.
Where should you complete the actions? To answer, drag the appropriate locations to the correct actions. Each location may be used once, more than once, or not
at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Components
* 1. To add code components to a canvas app:
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* 2. Navigate to Power Apps Studio.
* 3. Create a new canvas app or edit an existing app to which you want to add the code component.
* 4. Go to Insert > Custom > Import component.

NEW QUESTION 252
- (Topic 4)
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating a canvas app that displays a list of accounts.
Users must be able to select an account and view details for the account. The app must include a feature that brings the user back to the list of accounts.
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the screen. You set the data source of Gallery_Accounts to
Accounts and add another blank screen named Screen_AccountDetail.
You need to complete the app.
Solution:
? Add a display form to Screen_AccountDetail.
? Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail).
? Set the data source of the form to Accounts.
? Set the Item property of the form to Selected.
? Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate(Screen_Accounts).
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation: 
If you add a Display form control, the user can display all fields of a record or only the fields that you specify.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-form- detail

NEW QUESTION 256
- (Topic 4)
You use a Microsoft SharePoint list to record information about customers.
You must perform a series of actions only when a new item is added to a SharePoint list. You need to configure a Power Automate flow.
Which trigger should you use?

A. When an item is created
B. When an item is created or modified
C. When a file is created (properties only)
D. For a selected item

Answer: A

Explanation: 
Trigger - When an item is created Triggers when an item is created.
MS Flow will trigger when an item is created in the list. It will return all list item properties which can be used in the Flow.
Reference:
https://www.c-sharpcorner.com/article/sharepoint-based-triggers-in-ms-flow-part-2/

NEW QUESTION 257
DRAG DROP - (Topic 4)
DRAG DROP
A company uses Power Apps and Microsoft Dataverse.
The company has model driven apps across multiple Microsoft Dataverse environments in the same tenant. You must grant privileges to Power Apps makers to
achieve the following:
• Share model-driven apps in multiple Microsoft Dataverse environments.
• Share model-driven apps in only one of the Microsoft Dataverse environments and view only table records that they create themselves.
You need to share the model-driven app with users by using the principle of least privilege. Which security role privilege should you grant for each requirement? To
answer, drag the
appropriate security roles to the correct requirements. Each security the may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct answer is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 260
- (Topic 4)
A company creates an app that uses Microsoft Dataverse tables.
The app creator wants to verify that the app is operating as expected by using a sample set of real-world data.
You need to import the sample data into Dataverse tables.
Which two technologies can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Power Bl
B. SharePoint
C. Power Query
D. Dataflows

Answer: CD

Explanation: 
C: You can create a table in Dataverse and fill that table with data from an OData feed by using Power Query. You can use the same techniques to integrate data
from these online and on-premises sources, among others:
SQL Server Salesforce IBM DB2
Access
Excel Web APIs
OData feeds Text files
D: You can create a new Dataverse table that stores all the metadata from the dataflow run. For every refresh of a dataflow, a record is added to this table. You
can also store metadata for multiple dataflow runs in the same table.
Reference:
https://docs.microsoft.com/en-us/power-query/dataflows/load-dataflow-metadata-into- dataverse-table
https://docs.microsoft.com/en-us/power-query/dataflows/add-data-power-query

NEW QUESTION 262
DRAG DROP - (Topic 4)
You create a canvas app. You run App checker to validate the app. App checker returns error results.
You need to locate where the errors occur.
Which areas should you review? To answer drag the appropriate areas to the correct error messages. Each area may be used once, more than once, or not at all
You may need to drag the spirt bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
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NEW QUESTION 267
- (Topic 4)
A clothing retailer is creating a Power Virtual Agents chatbot in Microsoft Teams. The chatbot will use Microsoft Dataverse for Teams to provide sales metrics by
store.
A user wants to be able to ask the chatbot to see all the sales for pants.
You need to configure the chatbot to provide sales data for pants even when a user enters the terms jeans, slacks, or trousers.
Which chatbot component should you use?

A. Skills
B. Tables
C. Topics
D. Supported languages
E. Entities

Answer: E

Explanation: 
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

NEW QUESTION 268
HOTSPOT - (Topic 4)
HOTSPOT
A bicycle shop uses Microsoft Dataverse to track bicycle rentals and renter information. The bicycle shop has a standalone tablet with a canvas app. Renters use
the app to check out bicycles. Only one renter at a time can check out bicycles.
Multiple renters can rent as a team. You must expand the app to allow team rentals in one step. All team members must be registered under a single phone
number.
You need to modify the canvas app to display team and team member information, along with bicycle information
Which Ul elements should you use for each requirement? To answer, select the appropriate options m the answer area
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 270
- (Topic 4)
A company uses Microsoft Power Apps.
You need to create a canvas app to display a Microsoft Power BI report. The report must use the context of a selected record in the app. Data in a Power BI
control must be filtered to display the context of the selected record.
You need to propose the right solution.
Solution: Append filter parameter to Power BI report URL. Does the solution meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 272
- (Topic 4)
You create and publish a canvas app component library to perform complex calculations.
You discover an error in one of the calculations. You correct the issue and publish the canvas app.
You need to ensure that the co-worker uses the updated version of the component library.
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What should you do?

A. Export the updated component library and instruct the co-worker to import the updated version into the canvas app
B. Inform the co-worker to edit the canvas app and manually add the updated version of the component library
C. Instruct the co-worker to edit the canvas app and update the component library

Answer: C

Explanation: 
You can modify an existing component library and save any changes with additional version notes. However, the updated component library version must be
published for use in existing apps that use the component library.
Makers of other apps are notified of updated components being available. The notification appears when makers edit the apps in canvas app studio. They can
choose to update the components:

Select Review, and you'll see the option to update the component:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/component-library

NEW QUESTION 274
......
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